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ID6079-P This class teaches the common workflow process used in VRED Professional software to 
create high-quality, real-time renderings that realistically visualize design ideas. The class will begin by 
opening a native VRED (.vpb) design model as a real-time rendering in the default OpenGL render 
method. Students will learn to optimize the model by fixing the geometry and using Scenegraph to 
organize the parts. We will assign VRED Professional software materials and we will modify them to dress 
up the geometry so that the visual display is enhanced and the realism is improved. Finally, we will modify 
the render setting options to obtain a high-quality rendering, and then we will create an image for 
presentation. The class will finish with a brief discussion about the raytracing render method and how it 
creates renderings with physically correct lighting, reflections, refractions, and shadows. 

Learning Objectives 
 At the end of this class, you will be able to: 

• Work with Scenegraph and optimize the model geometry 

• Learn how to assign and modify materials 

• Learn how to apply an HDR image and set it as a background environment 

• Learn how to work with different render setting options in OpenGL rendering method and create an 
image 
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Renu Muthoo is an Instructional Designer with the Rand Worldwide Company, ASCENT-Center for 
Technical Knowledge. Her main role is to produce a variety of documentation, which includes developing 
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has extensive experience in creating photorealistic scenes using 3ds Max Design software, and she has 
extended her knowledge into the automotive visualization/presentation field using VRED Professional 
software. She is proficient in using materials and textures, illuminating scenes by providing optimum 
lighting, and using renderers to create believable and high-quality visualizations. 
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Autodesk VRED Professional Introduction 
The Autodesk® VRED™ Professional software is a visualization, analysis, and presentation tool 
for automotive and industrial designs. The high quality, real-time renderings enable you to 
realistically visualize, evaluate, and review your design ideas. The completed models can be 
used to produce imagery that can be used to showcase design prototypes, in presentations, or 
for marketing material. 

    
      Raytraced rendered image                   OpenGL rendered image 

The Mainville auto design is courtesy of Marc Mainville. 

Workflow  
The overall suggested workflow for creating an image for presentation or when using the real-
time renderer to convey your design intent is provided below: 
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Quick Overview of the Interface 
Once you open the Autodesk VRED Professional software, the screen consists of the main 
rendering window, with the interface tools along the top and the bottom of the application 
screen. The Autodesk VRED Professional interface is designed for intuitive and efficient access 
to commands and actions. 

 

Interface Components 

The components of the interface are: 

1. Menu Bar   2. Icons Bar   3. Quick Access Bar 
4. Modules   5. Render Window  6. Status Bar 

Input into Autodesk VRED Professional 
As Autodesk VRED Professional is a visualization software and not a modeling tool, the initial 
creation of the geometry is always an imported 3D CAD data. The 3D CAD data files can be 
imported into the Autodesk VRED Professional software from multiple data sources, including: 

• AutoCAD® drawing files (.DWG and .DXF), including objects created in vertical 
applications, such as the AutoCAD® Architecture software. 

• Autodesk® Inventor® files (.IPT and .IAM). 
• Autodesk® Alias® files (.WIRE). 
• Scene files from the Autodesk® Maya® (.MA, .MB), Autodesk® Showcase® (.A3S), 

Autodesk® 3ds Max®, or Autodesk® 3ds Max® Design (.3DS) applications. 
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• Autodesk® Revit® or Autodesk® Simulation designs, must be exported as .FBX files 
before they can be imported into the Autodesk VRED Professional software.  

• Other major CAD data applications and visualization software, such as CATIA, Creo 
Elements/Pro, SolidWorks, STEP, IGES, Deltagen, and Stereolithography (.STL) files. 

• Exchange files format, such as .OBJ and .FBX. 

How To: Open a Scene 
1. Click  (Open) in the Icons Bar, or select File>Open. 
2. In the Open File dialog box, locate the required folder. 
3. Select a file from the list. 
4. Click  or double-click on the file. 
5. If the type of file that you selected is not a VRED native file type (i.e., .VPB, .VPE, or 

.VPF), then the Import Options dialog box opens. Specify your options and click OK. 
6. Save the scene as a native .vpb file. 

How To: Set the Import Options 
The Import Options dialog box enables you to set options so that the software can convert and 
correctly process a 3D data file. The dialog box is only available for files that are not a native 
Autodesk VRED file format. Suggested options to be used while importing include: 

• In the Scene rollout, verify that Apply 
Materials from Asset Manager is cleared. 

HINT: By default, all imported materials are 
converted into VRED plastic materials. This option is 
set in FileIO tab of the Preferences dialog box. The 
VRED materials display the best shader quality in 
OpenGL and Raytracing render modes. 

• Select Center in Origin, Put onto the 
Ground, and Adjust Object Size.  

TIP: If you are expecting additional parts to be 
added to the model at a later stage, then leave the 
Center in Origin, Put onto the Ground, and 
Adjust Object Size options cleared. This will ensure 
that any additional parts fit perfectly with the model, 
as they are built using the original point of origin. 

• For Which size fits your object best?, 
drag the slider under the appropriate picture 
that indicates the relative model size. 

• In the Tessellation rollout, in Tessellation 
Quality, select High for a good quality 
rendering.              
                   Import Options dialog box 
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• Ensure that the first four options (Keep Surface Data, Merge Geometries, Create 
Groups for Layers, Remove Empty Groups) are selected. 

• Leave all other options at the default settings which are set for optimum results. 

Selecting Objects 
• Mouse: <Shift> + click 
• Window: <Shift> + click (left) and drag (right) to create a window 
• Crossing: <Shift> + click (right) and drag (left) to create a window 
• Scenegraph: Select object name 

Selection Display Styles 
When you select an object, either or both display options, 
Wireframe and Boundings (located in the Icons Bar) must 
be active to display the selected objects in the Render 
Window.                   Selection display styles 

 

Objective: Work with Scenegraph and optimize the model geometry 

Data Preparation 
• Organize and optimize the parts using Scenegraph 
• Adjust Geometry by fixing the surface normals 
• Transform Geometry 

Scenegraph 

Access: Quick Access Bar>  (Graph); Scene>Scenegraph; Shortcut menu>Scenegraph 

When you import a file from another CAD application, 
there might be a large number of nodes present in the 
Scenegraph. Use the Scenegraph to sort and group the 
objects together, complete the model by cloning objects, 
and optimize the geometry.  

The Scenegraph lists all of the parts and geometry that 
are present in the scene. The list is organized in the form 
of a hierarchical tree structure and each geometric part is 
called a node.  

TIP: Reduce the number of levels of hierarchy and have fewer 
number of overall nodes. Also, sort and group geometry 
together under relevant group nodes. 
TIP: Simplify the nodes to reduce the amount of data.  

           Scenegraph 
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Scenegraph hierarchy 
By default, the Root node lists the four camera views (Top, Side, Front, and Perspective) and 
the Environments node. Once you open a scene or import geometry into an empty scene, 
another node is added to the Root node which lists all the geometry in the scene. An icon 
besides each node indicates the characteristics of the node. 

Node Types 
Icon Description 

 (Regular group node) A group of objects is placed inside this node. 

 (Cloned group node) An exact copy of the parent regular group node’s 
contents. If any changes are made to the group node, it 
is reflected in its cloned group node as well. 

 (Transform group node) A transformation (i.e., move, rotate, or scale) has been 
applied to the objects in this node. 

 (Material node) Contains material information. 

 (Animation group node) Animation has been applied to the objects in this node. 

 (Geometry node) The polygonal geometry inside of a group node. The 
geometry is the last hierarchy node of a group and is the 
simplest form of node. 

 (Geometry node with 
Transformation) 

Transformation has been applied to the geometry only. 

 (Nurbs geometry node) A nurbs geometry inside a group node. HINT: You can 
reduce the amount of data to improve performance by 
converting the nurbs surface into polygons.  

 (Environment node) Contains information about the environment used in the 
scene. 

 (Light Transform node) Enables you to add transformations to light sources that 
have been created in a scene. 
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Scenegraph Shortcut Menu 
The Scenegraph shortcut menu is used to create, edit, and modify the nodes. Right-click on a 
node and select an option in the shortcut menu; the selected action is performed on all of the 
subordinate nodes of the selected node. 

Working in Scenegraph 
Selecting and Isolating Parts 
In the Scenegraph, select the object or objects and view them in the Render Window 
(Boundings and/or Wireframe selected). To display individual objects separately, drag and drop 
them into the Render Window, or right-click on the selected object and select Isolate View 
Selected, or after selecting an object, click  (Isolate) in the Icons Bar, or press <I>. 

TIP: While working in a large and complex scene with overlapping geometry, it is useful to isolate objects 
so that you can work on them separately. 

Reorder Nodes and Objects 
After importing a file from another CAD application, there might be a large number of nodes 
haphazardly present in the Scenegraph. For easily locating the parts, organize and group the 
nodes in a logical manner. Click and drag nodes to a new location as well as move subordinate 
geometry from one node to another by dragging and dropping it into another node. 

Group Objects 
Grouping enables multiple objects to be treated as a single unit, but still retain the ability to 
control each object separately. In the Scenegraph, right-click on the node and select 
Create>Group (<Ctrl>+<G>). Rename the new group 
logically and drag and drop the nodes. 

Optimize Module 
Access: Right-click node>Edit>Show Optimize Module; 
Scene>Optimize; Shortcut menu>Optimize 

Optimizing the model enhances the render capabilities and 
speeds up the rendering process. Using the default settings 
does not make any significant difference to the Scenegraph, 
but improves back end calculations and rendering speed. 
Some of the options include:  

• Cleanup Group Nodes – Removes empty nodes. 
• Merge Geometry Nodes – Consolidates the extra 

nodes. 
• Flush Transformation Nodes- Converts 

Transformation group nodes to regular group nodes. 
• Flush Material Group Nodes – Converts Material 

group nodes to regular group nodes.                Optimize Module 
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Adjust Geometry 
After importing the objects into the scene, there might be some discrepancies in the geometry 
that need to be fixed before you modify or manipulate the design for presentation. For the 
geometry to render properly, the surface normals should always be facing towards the camera. 
If the normals are reversed, shadowing effects are created and the rendering is flawed. 

Checking geometry 
Access: Visualization>Vertex/Face Normal Rendering; <F5> 

To visually inspect the orientation of the normals, change to the Vertex/Face Normal mode 
where the geometry is displayed in different colors. Each color indicates a specific orientation of 
the face and vertex normals. The colors indicate: 

• Green: Face and vertex normals facing correctly. 
All the geometry should be green.  

• Blue: Normals reversed for both faces and 
vertices. 

• Gold: Face normals reversed, vertex normals 
correct. 

• Violet: Face normal correct but vertex normals reversed.     Vertex/Face Normal Mode 

Fixing Geometry  
Access: Scene>Geometry Editor; Shortcut 
menu>Geometry Editor  
To correct the orientation of the surface normal, use 
the options in the Normals tab>Normal Calculations 
rollout>Flip Normals area of the Geometry Editor 
Module. The options are:  

•  - Repairs blue surfaces 
•  - Repairs gold surfaces 
•  - Repairs violet surfaces 
• If a few surfaces of a selected part require to 

be repaired, hold <Alt> and right-click on the 
individual surface.       Geometry Editor>Flip Normals   

How to: Prepare the Data  
1. Open the Scenegraph module. 
2. Investigate the hierarchy of the nodes and also investigate the 

listed node types by expanding the nodes using +/- and the 
slider bar. 

3. Using the Scenegraph, sort and group the objects together. 
Right-click on a node and select Create>Group, rename the 
newly created Group node, and drag and drop the required 
geometry nodes into the new group node.                    Create/Rename Group node 
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4. Logically consolidate the geometry nodes under a single group node. Remove any 
empty group node using the Optimize module (Cleanup Group Nodes). 

          
            Original hierarchy   Consolidating by drag and drop      Optimize (Cleanup Group Node)  

5. Reduce the complexity of the models by changing  (Nurbs Geometry) and 
 (Material) nodes to simple  (Geometry) nodes.  
a. Set Flush Material Group Nodes option in the Optimize module to simplify 

 (Material) node. 
b. Right-click on the group node containing  (Nurbs Geometry) and select 

Edit>Surfaces>Convert to Mesh to simplify it.  

 
                 Nurbs geometry nodes converted to simple geometry nodes 

6. After simplifying nodes, sort, consolidate, and optimize the nodes again. 
7. Visually check the normals by selecting Visualization>Vertex/Face Normal Rendering, 

or press <F5> to enter the Vertex/Face Normal rendering mode.  
8. In the Render Window, select the geometry that is not green in color. 
9. Depending on the color, click on the appropriate button in the in the Flip Normals area of 

Geometry Editor Module to make them green (correct orientation). If a portion of a single 
object needs correction, use the <Alt> + right-click option. 

10. Select Visualization>Realistic Rendering, or press <F3> to return to the Realistic 
Rendering mode. 
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Objective: Learn how to assign and modify materials 

Material Editor 
Access: Quick Access Bar> (Materials); Scene>Material Editor; Shortcut menu>Materials 
The Material Editor is an interface for listing, creating, converting, modifying, and assigning 
materials. It enables you to create a new material by modifying the attributes of an Autodesk 
VRED Truelight material. There are 17 pre-defined Truelight materials available in the software. 
These are designed specifically for automobile visualization. Each material contains attributes 
that are specific to the selected material for detail enhancement. Each material can be modified 
by adjusting its attributes. The Material Editor also enables you to convert the imported 
materials to VRED Truelight materials and modify them as required. 

 
      Material Editor Sections 

Groups, Tags Section  
The Groups, Tags section contains a list of all the materials that are present in the scene. Right-
click anywhere in this section to open the materials shortcut menu which provides you with the 
following options:  

• Create Material: Contains a list of Truelight materials that can be customized, as 
needed. 

                    
  Create Material          Convert>To Truelight Material 

Groups, Tags (Lists materials) 

Preview 

Attributes 

Toolbar 
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• Convert>To Truelight Material: Converts the imported materials to Truelight material. 
• Create Environment: Creates a new environment, skylight, or an environment switch. 

Attributes Section  
The attributes for a material are grouped in rollouts. 
The first few rollouts provides attributes that are specific 
to the Truelight material that was used as a base 
material (Chrome material), while others are common to 
all of the Truelight materials. 

• Incandescence: Sets properties like color and 
intensity for self-illumination. 

• Transparency: Sets transparency. For 
complete transparency use See Through option. 

• Displacement: Sets the height information for 
2D images. 

• Raytracing: Options for raytracing. 
• Common: Options for Occlusion color, intensity, 

and lighting mode.              Material Attributes 

In addition to the common attributes, each material has its own specific attributes. Some of the 
specific attributes are as follows:   

• Texture Channels: Depending on the material, texture channels might be available.  
Sets texture maps in four channels (Diffuse, Glossy, Roughness, and Bump). 

Diffuse Texture Attributes  
• Use Structure: For some materials (Brushed Metal, Plastic), the Use Structure options 

(generally in the Bump Texture rollout) can be used to create an inbuilt texture and bump 
effect. It provides you with options to set the direction and the depth of the metal grain. 

TIP: You can achieve high-quality renderings using the Truelight materials as they have the capability of 
generating accurate lighting effects. 

Save 

Delete 
Reload 

Load 
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Some VRED Truelight Materials 
• Chrome: Reflective metallic surfaces. 
• Brushed Metal: Less reflective metal surfaces (wheel rims). 
• Glass: Transparent or frosted glass material. 
• Metallic Carpaint: Highly reflective metallic painted surfaces (car bodies). 
• Flipflop Carpaint: Color variation based on the viewing angle. 
• Triplanar: Surfaces with texture mapping (leather or fabric surfaces: car seats). 
• Tire: Textures for treads and sidings. 

    
                              Chrome Material       Glass Material    

    
Brushed Metal Material    Metallic Carpaint Material 

 
Tire Material 
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How to: Convert Material  
1. Open the Material Editor. 
2. In the Groups, Tags section, select a material which needs to be converted. (By default, 

while importing models, the materials are converted to plastic material) 
3. In the Render Window, identify the parts that have the selected material and determine 

the material that is appropriate for the parts. 
4. Rename the material to be converted. Right-click on the material and select Convert>To 

Truelight material>new material. 
5. In the Attributes section, modify the settings as per your requirements. 

               
                   Plastic Material with the name Teak Renamed to INT_leather_yellow and converted to Triplanar 

How to: Create and Assign Material 
1. Open the Material Editor. 
2. In the Groups, Tags section, right-click anywhere and select Create Material>new 

material. Rename the new material, as needed.  
3. Select the parts that require the new material. In the Material Editor, in the Groups, Tags 

section, right-click on the new material and 
click Apply to Selected Nodes. 

4. In the Attributes section, modify the settings 
as per your requirements. 

         
  New material EXT_tire_back using the Tire Truelight as its base material; using textures for Markings and Profile 
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Assign Materials 
After materials have been created, you need to assign them to the geometry so that they are 
visible in the Render Window. Methods of assigning materials to the geometry: 

• Dragging from the Material Editor and dropping in the Render Window. 
• Dragging from the Material Editor and dropping in the Scenegraph. 
• Copying and pasting material. <M>+click to copy and <M>+right-click to paste. 
• Using the Material Editor (Shortcut menu>Apply to Selected Nodes; Toolbar> ). 

 

                    
                              Drag/drop in the Render Window                         Drag/drop in Scenegraph 

        
Copy and Paste material    Using Material Editor 

Ambient Occlusion 
• The Autodesk VRED Professional software uses Ambient Occlusion (AO) to simulate 

shadows. AO uses shaders to calculate the extent to which an area is inhibited by 
incoming light, thus enhancing the detail in dark crevices, cracks, and along edges.  

• AO is NOT physically accurate and is not based on any physically accurate light. It 
imitates the effects of light and approximates shadows. 

• AO is created separately and its calculations are used to define the shadows with the 
OpenGL rendering mode, as well as some options in the Raytracing rendering mode. 

TIP: For high quality rendering, the result with AO should be smooth and is dependent on the level of 
detail of the selected geometry. The higher the density of the wire mesh of the geometry, the better the 
quality of shadow using AO. 
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Checking AO 
Access: Visualization>Ambient Occlusion Rendering; 
<F7> 
To visually examine if the shadows have been calculated 
using AO or if the calculated shadows are smooth, change 
to the Ambient Occlusion visualization mode. In this 
mode, the geometry is displayed without any materials, 
making it easier to examine the quality of the shadows. 

Calculating AO 
Access: Scene>Ambient Occlusion; Shortcut 
menu>Ambient Occlusion 

To calculate the shadows or to improve the quality of 
already calculated shadows, use the options in the 
Ambient Occlusion module. The sections include: 

• Direct Illumination: Sets the shadow quality. The 
higher the quality, more samples are created. 

• Indirect Illumination: Sets indirect illumination. 
• Subdivision: Sets the quality of Subdivisions. To 

improve the quality, increase the subdivisions.        Ambient Occlusion Module             

How to: Calculate Ambient Occlusion 
1. Select the geometry for which you need to calculate Ambient Occlusion. 
2. Open the Ambient Occlusion module (Scene>Ambient Occlusion). 
3. In the Direct Illumination rollout, select the Shadow Quality as required. 
4. In the Indirect Illumination rollout, select Enable, and then select the Quality required.  
5. Click . 
6. To examine the AO in the Render Window, change to the Ambient Occlusion rendering 

mode. (Visualization>Ambient Occlusion Rendering; <F7>). 
•  The results in the Ambient Occlusion rendering mode display without the materials 

and should be smooth without any blotchiness. 
7. Return to the OpenGL rendering mode (Visualization>Realistic Rendering; <F3>). 

            
  AO calculated with problem areas            Applied Subdivision and problem areas fixed 
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Objective: Learn how to apply an HDR image and set it as a 
background environment 
Environments 

Access: Quick Access Bar> (Materials); Scene>Material Editor; Shortcut menu>Materials 

The Autodesk VRED Professional software uses a default environment (named Studio) for all 
new scenes. The environment consists of a background image, along with its associated 
lighting, shadows, highlights, and reflections. The environment acts to enhance the visual 
display of a model and improve realism. The background of an environment is a High Dynamic 
Range (HDR) image. To add, remove, or modify the environment use the Material Editor. Select 
the environment in the Material section to display its attributes and modify as required. The 
rollouts include: 

• Environment Material: Enables you to load, save, and reload the HDR image. You can 
use the Is Visible option to remove the HDR image and use a simple background color. 

HINT: If Is Visible is cleared and the background color is used, the lighting from the HDR image 
is still used although the image is not visible. 

• HDR Light Studio: Enables you to load and save the current HDR Light Studio Project. 
A separate HDR Light Studio plugin is required for additional options. 

• Color Correction: Enables you to work with values for exposure levels, hue color, 
contrast/brightness and other color related options. 

• Transformation: Enables you to reposition the HDR image. 
• Raytracing Settings: (Available in Raytrace rendering mode.) Enables you to set the 

illumination modes for still frame and interactive raytrace renderings. 

Material Editor> Environment Attributes 
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How to: Create a new environment with a new HDR image 
1. Open the Material Editor. 
2. Right-click anywhere in the Groups, Tags section and select Create 

Environment>Sphere Environment. 
3. In the Load Environment Image dialog box, open the hdr image. 
4. In the Groups, Tags section, the new material node is created with the  icon indicating 

that it is an environment. Select the new environment to display its attributes. 
5. Make the color corrections or reposition the image. 

   
Initial position of the environment                Environment repositioned to display the buildings as backdrop 

 

TIP: Every new environment uses a unique shadow plane. Shadows of the geometry with the ground 
must be calculated for each environment used. 

How to: Calculate the Ambient Occlusion for the new shadow plane 
1. In the Ambient Occlusion rendering mode (Visualization>Ambient Occlusion;<F7>), 

visually check that there are no shadows with the new environment. 
2. Open the Scenegraph and expand the EnvironmentsTransform>Environments. 

Expand both the Studio and the newly created environment. 
3. Open the Ambient Occlusion module. 
4. In the Scenegraph, select Studio>ShadowPlane. 
5. In the Ambient Occlusion module, select Settings>Load from Node. This automatically 

loads the settings of the selected shadow plane which is the Studio Shadow Plane. 

 
     Loading Studio Shadow Plane Settings 
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6. In the Scenegraph, select the new shadow plane geometry. In the Ambient Occlusion 
module, click Calculate All.  

7. In the Ambient Occlusion rendering mode notice the shadows of the geometry with the 
plane. 

        
      No AO for the new shadow plane                           AO calculated for the new shadow plane 

8. Select shadow plane in the Scenegraph and in the Material Editor, right-click, Create 
material>Shadow. The new shadow plane material is created in the Material Editor. 

9. Modify the shadow plane material settings.  

 

            Shadow Plane Attributes 
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Objective: Learn how to work with render setting options in 
OpenGL rendering method and create an image 
Rendering 
By default, the view that is displayed in the Render Window is interactively being rendered using 
the OpenGL render mode. Two rendering methods are available in the software: OpenGL 
rendering and Raytracing. 

• OpenGL render method- Uses the GPU (Graphics Processing Unit) to render 
calculations, resulting in a fast response time rendering.  
Access (if Raytracing is on): Icons Bar> clear  (Raytracing); clear 
Visualization>Toggle Raytracing; <F3> 

• Raytracing- Uses the CPU (Central Processing Unit) and can be used to calculate 
physically correct lighting, reflections, refractions, and shadows. It can affect the speed 
and performance of the software.  
Access: Icons Bar>  (Raytracing); Visualization>Toggle Raytracing; <F4> 

• The rendering mode that is currently used is indicated in 
the Status Bar as RR-GL: OpenGL or RR-RT: Raytracing. 
            Status Bar-Render Modes 

Render Settings 

Access: Quick Access Bar>  (Render); Rendering>Render Settings; Shortcut 
menu>Render Settings 
Before you save a rendered image, review and adjust the 
render settings for the scene using the Render Settings 
module. The various tabs are: 
 
File Output tab 
Commonly used options: 

• View: Sets the Camera view for rendering. 
• Filename: Sets the location for saving the rendering. 
• Image Size Presets: Sets the size for the rendered 

image. 
• Printing Size: Sets the size for printing the image. 
• Resolution: Image resolution (pixels per inch).  
• Region Render: (Available with Raytracing.) Sets 

the region for rendering.   

HINT: Using the cursor to define the region, click 
(Region) in the Icons Bar, press <R>, and then use the 
cursor to create a window. Click  to activate 
the selected area.                      Render Settings>File Output 
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• Render Mode: Sets the Illumination modes for still frame rendering. The modes are 
CPU Rasterization, Precomputed Illumination, Precomputed + Shadow, 
Precomputed + IBL, and Full Global Illumination. 

• Render Quality: Sets the render quality (i.e., Draft-32 image samples. Preview-128. 
Production: 512, Production Interieur-2048, Custom- any user defined number).  

General Settings tab 
The options in this tab are used to adjust the quality of the image by smoothing the edges 
(antialiasing). The options are used to adjust the quality of image while antialiasing.  
Antialiasing 

Access: Icons Bar>  (Antialias); <SpaceBar> 

Antialiasing is the process of smoothing edges and removing jagged diagonal lines that display 
in the Render Window. This process improves the display quality of a scene substantially. 

 
• If Antialiasing is activated, the smoothing of edges starts as soon as you stop navigating 

(release the mouse button) in the Render Window. The start of antialiasing is indicated 
by the percentage calculation wheel attached to the cursor. If you click in the model, the 
antialiasing is aborted and restarts as soon as you release the mouse button. 

• The percentage of antialiasing that is completed, along with the render time remaining, is 
displayed in the Status Bar and is also attached to the cursor. 
 

 
Status Bar- Antialiasing percent  Cursor- Antialiasing percent 

Raytracing Quality tab 
This tab provides you with options to set the raytracing settings. 

How to: Create a Rendered Image in OpenGL 
1. Set the orientation of the scene for creating an image. 
2. Review the scene and check if the edges of the geometry are all smooth. To improve the 

visual display, activate antialiasing. 
3. Once the antialiasing is complete, without clicking anywhere, review the scene and 

ensure the edges have been smoothed. 
4. Open the Render Settings module. 
5. Set the size for the image using Image Size Presets. (File Output tab>Image rollout) 
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6. Set the Render Quality to Production for the final image. Otherwise use a lower quality 
if you are at the checking stage.  

HINT: The selected option in the Render Quality is reflected in the General Settings 
tab>Image Samples as Render Quality and Image Samples are interdependent. For 
example, if you select Draft as Render Quality, the Image Samples are automatically set 
as 32 and vice versa. Similarly, changing the Render Quality to Preview sets the Image 
Samples as 128 and so on.  

 

7. In the General Settings tab, set Adaptive Sampling to High Quality for the final image. 

 
              Adapdive Sampling: High Quality 

8. Ensure that the rendering looks as required and then click . 
9. In the Save Rendering dialog box, save the image as a .png file. 
10. Open the rendered image to review it. 

 
                        Rendered Image using OpenGL  
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Additional Information 

Illumination modes in Raytracing 
In the Render Settings Module, the Raytracing Quality tab provides you with options to set the 
raytracing settings.  

The Illumination Mode rollout provides you with different types of illumination options that can be 
used when rendering with Raytracing. These illumination modes can be set for both Interactive 
or Still Frame rendering.  

 

Illumination modes 
 
CPU 
Rasterization 

Works similar to the OpenGL mode, but the computation processes are 
handled by the CPU. This illumination mode can be used for huge 
datasets, or when your graphic card performance is not sufficient for the 
kind of scene you want to render. It does not compute direct reflection or 
refraction, and therefore is not used for photorealistic visualizations.  

Precomputed 
Illumination 

Uses the Ambient Occlusion (AO) shadows that are baked on the 
geometry, along with precomputed indirect illumination. It only calculates 
the reflections, refractions, and correct shadows from the light sources 
that are present in the scene. 

Precomputed 
+ Shadows 

Uses the precomputed Image Based Lighting (IBL) and indirect 
illumination. This mode does not use the precalculated AO, but calculates 
the shadows from the currently active scene environment. 

Precomputed 
+ IBL 

Uses the precomputed illumination, but calculates the IBL. In addition, this 
mode calculates and generates glossy reflections. 

Full Global 
Illumination 

Global Illumination (GI) algorithms describes how the interaction of the 
light is physically correct with multiple surfaces. As the name specifies, 
Full Global Illumination computes complete illumination in the scene, and 
thus produces high quality realistic images. 
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Downscale 
During Raytracing, the rendering calculations are performed by the CPU. To ensure efficient 
navigation in the Render Window, the display quality should be reduced using Downscale. 

Access: Icons Bar>  (Downscale);  
• Levels of downscale - Low, Medium, or High. 

            
Downscale levls                            Low Downscale                                       High Downscale 

 

HINT: Downscale is available while using Raytracing render mode because the performance is 
significantly dependent on the number of pixels to be rendered. In OpenGL, reducing the number of pixels 
has virtually no effect on performance. 

How to: Create a Rendered Image of a Region in Raytracing 
1. Open the Render Settings Module. In the Raytracing tab, set both Interactive and Still 

Frame to Precomputed Illumination. 
2. In the Icons Bar, click  (Raytracing). Wait till the Raytracing calculations are 

complete. 
3. Orbit around and ensure that the scene is at the final stage of display and no changes 

are required.  
4. In the Render Settings module, in the Raytracing Quality tab, in the Illumination Mode 

rollout, set Interactive to Full Global Illumination. 
5. Orbit around the Render Window and notice how hard it is to navigate. Select 

Downscale and use different levels of downscale till you can navigate around efficiently. 
6. Set the point of view of the scene for creating an image. 
7. Set the size for the image using Image Size presets. (File Output tab>Image rollout) 
8. Set the Render Quality to Production for the final image. 
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9. Enable Render Region by selecting it. 
10. Toggle off Downscale. 
11. In the Icons Bar, click  (Region). Press <R>, and then using your cursor, click and 

drag to define the upper left and lower right corners to create a window. 

     Creating Region Window 

12. In the Render Settings module, in the File Output tab, click  to activate 
it. The coordinates in the Upper Left Corner and the Lower Right Corner are 
automatically calculated as per the created window. 

13. Render the image for the region and save. 
14. Open the image to review it. Notice the physically accurate reflections created near the 

front and along the bottom of the grill. 

 
   Raytraced image   OpenGL image 
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Conclusion 

The Autodesk VRED Professional software enables you to create high-quality realistic images 
for presentation, or use the real-time renderer (either OpenGL or Raytracing) to convey your 
design intent. As the software renders in real-time, it enables you to realistically visualize, 
evaluate, review, and then successfully present your design ideas.  

OpenGL: As the scene is being rendered interactively in real-time, in the default OpenGL 
renderer, it is easier to navigate in the scene, transform the geometry, modify materials or 
cameras, and then output images. The renderings created in this render mode are near 
photorealistic and are calculated quickly, thus making it easier to work with. 

Raytracing: Raytracing is used to calculate physically correct lighting, reflections, refractions, 
and shadows. Depending on the illumination mode you are using, you can add realistic 
shadows and reflections to the scene to produce very high-quality, photorealistic visualizations. 

    
      Raytraced rendered image                   OpenGL rendered image 
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